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SB200a Specifications 

Maximum layer count 64+ 
Via rules Conventional, blind and buried 
Materials library Foils 

RCC foils 
Cores 
Pre-Preg 
Solder mask 
Ident 
Peelable mask 
Coverlay 

Post press compensation Yes (user defined) 
Finished thickness 
compensation 

Yes 

Cu thickness calculation Yes 
Board thickness calculation Yes 
User library Yes 
Save builds Yes 
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Personal Computer Requirements 

Computer IBM PC AT or compatible 
Processor Pentium 1GHz or better  
Operating system Microsoft Windows 98, Windows NT 4.0 SP6, 

Windows 2000 SP4, Windows 2003 SP1, 
Windows XP SP1 or later 

Environment Latest .NET framework installed 
System memory required 128MB recommended 
Hard disk space required 200MB (min.) 
Video standard XGA (1024 x 768) or higher 

Hi color 16 bit or higher 
CDROM drive  
Mouse Microsoft compatible 
Licensing Fixed: Parallel/USB key 

Floating FlexLM licence 
(Windows servers only) 
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Guide To The Manual 

Introduction Introduces the Polar Instruments SB200a. 

Installation/set up Instructions for installing/uninstalling and activating 
the SB200a software. 

Using the SB200a  Discussion of the SB200a user interface; creating 
and editing stackups. 

Adding controlled impedance 
structures 

Working with the Si8000/Si9000 field solver to add 
controlled impedance structures to the stackup 
model. Using the goal seeking facilities of the field 
solver to obtain the correct impedance for a 
structure. 

The SB200a Materials 
libraries 

Using the SB200a materials libraries, creating new 
libraries, adding material to the library. 

Design rule checking Using the SB200a Design Rule Checker to correct 
stackup design errors. 
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Introduction to the SB200a 

The SB200a Stackup Design System 
The Polar SB200a PCB Stackup Design System is designed 
to reduce the amount of time consumed in PCB stackup 
documentation and control. The SB200a offers both 
interconnect designers (PCB layout engineers) and PCB 
front-end engineers a fast and professional solution to layer 
stackup creation. The SB200a is both graphical and easy to 
use while providing formal documentation for everyone 
involved in ensuring the correct materials are used in the 
build process. The SB200a allows the user to view stackup 
in 2d or 3d format. Layer and material annotation is clear and 
easy to read and each layer may be selected and queried to 
display the associated material type and properties, including 
the associated data file. Visible drill information ensures that 
designers instantly know which layers support conventional, 
blind and buried vias. The SB200a allows you rapidly to build 
and share stacks and verify via aspect ratios and track 
spacing rules. The stack contains base material information 
combined with layer description and a complete listing of 
transmission line structures deployed in the stack. Keeping 
all stack information in one file ensures that manufacturing 
data is accurately shared between original designer and 
fabricator. 

Integration with the Si8000/Si9000 
The SB200a is fully integrated with the Si8000 Controlled 
Impedance Quick Solver and the Si9000 PCB Transmission 
Line Field Solver so the user can quickly add controlled 
impedance structures to layers in the stackup. Using the 
Goal Seek facility of the Si8000/Si9000 the designer or board 
fabricator can rapidly arrive at the controlled impedance 
structure parameters to produce the target impedance. 

Materials library 
The SB200a supports a flexible materials library. This allows 
the designer to use standard materials data, and also 
provides the facility to create new material libraries. PCB 
fabricators can also build libraries of commonly stocked 
materials to give interconnect designers visibility of materials 
held in stock. Materials libraries may be downloaded from 
most popular base material suppliers in the Polar Material 
Partner program.  
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Preferred builds 
PCB fabricators are able to create and share preferred builds 
and exchange this information with designers. Build 
information also includes blind and buried via information, 
simplifying sharing stackup and drilling information between 
board shops and the design community. 

Dimensional information 
Finished thickness is a critical dimension in many applications; 
the SB200a keeps track of finished thickness and tolerance, 
and allows fabricators the flexibility of adding in house post 
press thickness for prepreg layers; the SB200a takes into 
account plating thickness where appropriate. 

High layer count boards 
On boards with high layer counts changes can result in a 
non-symmetrical stack. The Design Rules Check checks for 
symmetry across the stack, and ensures material symmetry 
is maintained. Symmetrical build mode can be set to ensure 
that any changes are applied equally across the stack. 

Documentation 
In addition to saving the stack in efficient electronic format, the 
stack graphics can be output in a variety of formats, GERBER, 
DXF, bitmap or JPEG. In addition the stack data can be 
exported in comma-separated form for inclusion in other 
systems. Customisable printouts make it easy to discuss 
alternate builds and pricing impacts with fabricators. 

Supplier management 
When multiple sourcing PCBs or when moving from 
prototype to volume production, the stack and fabrication 
design rules checks ensure that you do not overlook the 
manufacturing capabilities of your chosen suppliers. In 
addition the professional documentation output from the 
SB9000 ensures that layer stack information is accurately 
conveyed from your team to your PCB suppliers. 

Graphical interface 
The SB200a offers an easy to interpret graphical interface. 
Clearly showing the layers supporting blind and buried vias, 
the SB200a also records the data file for each layer 
(including ident and peelable mask layers). The graphical 
interface is especially designed to simplify the process of 
communication between interconnect designer and 
fabricator. OEMs who need to manage boards sourced from 
multiple suppliers will also find this facility invaluable. In 
addition to physical layers the SB200a adds mask and 
notation for electrical layers. 
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Installing the SB200a 

Activating the SB200a 
Activation will depend on the license purchased. It will be 
necessary to activate the product license prior to performing 
calculations with the SB200a. The SB200a is licensed using 
the MacroVision FlexLM License Manager via a license file 
on a license server or the local machine or a software key 
connected to either the parallel port (typically LPT1) or a 
USB port. The FlexLM licensing files should be installed and 
running on a locally accessible server (the server must be 
running to manage licensing) or on the local machine for a 
node-locked license.  

Licensing the SB200a using FlexLM 
When the first stackup build is performed the SB200a 
FlexLM License finder asks for the name of the License 
Server or License File. 

 
Ensure the Specify the License File option is selected and 
press Next. 

Activation using a node-locked license 
Enter the name of the license file or browse the local 
machine to locate the license file and press Next. 

Activation using a license server 
Enter the name of the license file or browse the network to 
locate the license file and press Next. 
The name of the license server will normally be the Network 
Identification name of the computer acting as the Licensing 
Server. 
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The SB200a will perform stackup builds within the terms of 
the license purchased. 

Installing the software key 
If a software key is used insert the key into the parallel 
printer port or USB port; if required, plug the printer cable 
into the software key. Locate the license file as described 
above. 
Note: If installing the software key on a Microsoft Windows 
NT or Windows 2000/XP system it will be necessary to be 
logged on as Administrator. 

Uninstalling the software 
To uninstall the SB200a software click the Windows Start 
button and choose Settings and Control Panel. 
Double-click Add/Remove Programs and choose SB200a 
from the list. Click Remove. 
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Using the SB200a Stackup Design System 

The SB200a Stackup Design System 
Double-click the SB200a icon to start the SB200a program. 
The main screen is displayed. 

 
The SB200a screen comprises: 

• The menu bar — drop-down menus containing all the 
SB200a commands 

• The tool bar — incorporating short cut tool buttons to 
the most common menu commands 

• The stackup build and construction window — where 
the board stack up is built and edited 

• The Controlled Impedance window displaying the 
controlled impedance structures (if any) for the 
selected layer. 
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• Stack Up Notes/DRC (design rules check) — a free 
form text area for explanatory or commentary 
notes/DRC 

• Stack Up Information properties area — table 
containing information related to the whole stackup. 

• Selected Item Information area — properties table 
containing the attributes of the layer currently selected 
in the stackup 

The SB200a Menu System 

The File menu 

 
The File menu allows for creation of new stackups and 
projects and opening, saving, printing and converting existing 
stackups and projects. 

Saving stackups 
Click the Save button to save the stackup. Users are 
recommended to save the stackup frequently during the 
stackup creation process to avoid data loss; stackups are 
saved as .stk files 

Saving projects 
Stackups that incorporate controlled impedance structures 
are saved as projects. Use the Save Projects command to 
save a stackup and its controlled impedance structures; 
projects are saved as .sci files. 

Printing stackup information 
To print the stackup information, choose the Print… 
command from the File menu. Select to print either a 
summary report or a full output. 

Exporting stackup information 
The SB200 incorporates the facility to export the printed 
output in XML, Gerber, DXF, CSV as well as graphic image 
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formats. From the File menu choose the Export To command 
and choose the format from the Export To sub-menu. 

 

Backing up stackups and libraries 
It is strongly recommended that stackup files (assigned the 
.stk extension), project files (assigned the .sci extension) and 
library files (assigned the .mlbx extension) be backed up to a 
secure location. 

The Edit menu 

 

The Edit menu contains the commands necessary to create 
and modify board stack ups. The designer or fabricator 
works within the free-form stackup build and construction 
window and adds layers of core, prepreg, foil, etc., from the 
materials library. 
Layers can be changed to signal, plane or mixed, moved up 
or down or copied and pasted, or assigned properties as 
required. 
The SB200a will apply design rules to the finished stackup to 
ensure compliance with good board design, (for example, the 
SB200a will check for symmetrical layers, misplaced layer 
types, adjacent copper layers, etc.) 

The View menu 
The View menu allows the SB200a to display the stackup in 
a 2-dimensional or 3-dimensional aspect. 
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The SB200a toolbar 
The SB200a toolbar comprises shortcut links to the most 
popular commands. 

 
Note: the toolbar buttons will  
Pause the mouse over each tool button to display the tool’s 
screen tip 

File operations 

 Create new stackup 

 Stackup Wizard 

Stack Building Operations 

 Symmetrical Mode 

 Mirroring Mode 

 Add layer to the stackup 
Click to select the layer type. The list of layer types is 
displayed in the associated sub-menu. 

 
Layers available include: 
Foil… Add foil layer to the stackup 
Prepreg… Add prepreg layer 
Core… Add core layer 
Soldermask… Add solder mask 
Coverlay… Add Coverlay layer 
Ident… Add screened ident layer 
Peelable… Add peelable mask 
RCC… Add resin coated copper layer 

    Add mechanical/laser drill between layers 
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Editing the stackup 

 Delete selected stackup layer or drill 

 Swap selected material 

 Copy material of the selected layer 

 Paste material above selected layer 

 Paste material below selected layer 

 
Set the selected electrical layer as a 
signal layer 

 
Set the selected electrical layer as a 
mixed signal/plane layer 

 
Display properties dialog for the 
selected layer or drill 

 Set the selected electrical layer as a plane 

 Move selected layer up one layer 

 Move selected layer down one layer 

 Apply Finished Thickness   

 Reset Finished Thickness 

Changing the stackup view 

 Display 2-dimensional view 

 Display 3-dimensional view 
Managing the materials library 

 Display materials library 
Exchanging data with the Si8000 or Si9000 Field solver 

 
Copy controlled impedance data to 
Field Solver 

 
Paste Controlled Impedance Data 
From Field Solver 
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Configuring the SB200 
When first run, the SB200 environment is initialised to its 
factory settings. These may require adjustment before 
outputting a finished stackup and/or project. Select the 
Tools|Options menu to change the default settings. 

Manufacturing Constraints 
The Manufacturing Constraints options consist of a collection 
of manufacturing capabilities. They may refer to differing 
levels of technology offered by PCB manufacturers. The 
required information can normally be obtained from the 
manufacturer or the manufacturer’s website. 

Finished Thickness 
Finished thickness is a critical dimension in many 
applications; the SB200a keeps track of finished thickness 
and tolerance, and allows fabricators the flexibility of adding 
in house post press thickness for prepreg layers. The 
SB200a also takes into account plating thickness where 
appropriate. 

 

Finished thickness is the thickness of a prepreg after 
pressing between two solid sheets of copper, and should be 
defined in the materials library; it will be a lower value than 
the Base Thickness. This value will be dependant upon the 
board shop’s process parameters. 

SB200 H Value calculation 
The SB200a is fully integrated with the Si8000 Controlled 
Impedance Quick Solver and the Si9000 PCB Transmission 
Line Field Solver so the user can quickly add controlled 
impedance structures to layers in the stackup. Using the 
Goal Seek facility of the Si8000/Si9000 the designer or board 
fabricator can rapidly arrive at the controlled impedance 
structure parameters to produce the target impedance. The 
H Value calculation produces the dielectric heights required 
for the Polar SI8000/9000 field solvers. 
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Isolation Distance 
Copper may be embedded into the prepreg from either or 
both sides. Embedding copper in the prepreg reduces the 
thickness from the Finished Thickness. This reduced 
thickness is referred to as the isolation distance. Where more 
than one prepreg layer is involved the reduction is averaged 
across all the prepregs. A figure for isolation distance of less 
than zero implies an impossible build, i.e. the embedded 
copper totals more than the thickness of the prepreg.  

 

 
The H Value is the sum of the isolation distance and the full 
thickness of the adjacent copper(s). However this does 
depend upon the controlled impedance structure and the 
layer type. Where a structure straddles one or more copper 
layers the full intervening copper thickness are added to the 
sum of the prepreg isolation distances. Power plane copper 
is not included in the H Value. Where a structure straddles a 
mixed layer, the copper of the mixed layer is included in the 
H Value, but if that mixed layer is the power plane for the 
structure the thickness of the copper is ignored. The H Value 
may be larger than the Finished Thickness because those 
areas of prepreg where there is no copper embedded are 
subjected to less pressure than they would be if all areas 
were covered with copper. An H Value larger than Base 
Thickness implies an impossible build. The H Value used in 
a structure can be calculated by summing the isolation 
distances, the intervening copper finished thickness and the 
signal trace thickness where applicable. 
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Thickness Options  
To specify the finishing method, choose Tools|Edit Thickness 
Options and click Copper Coverage or Simple Percentage. 

 
Each method requires that the amount of copper to be added 
where plating is required be set. In addition, where the 
Excess Resin design rule check is used the minimum 
acceptable value must be set. 

Copper Coverage method 
The Copper Coverage method allows the user to set the 
amount of copper that will be embedded into the prepreg. 
This can be set as a single value for each electrical layer 
type. Alternatively the amount of copper embedded will be 
calculated on an electrical layer by layer basis dependent 
upon the copper coverage for the layer set in the properties 
window. The greater the copper coverage the smaller the 
amount of copper embedded. 

 

12  •  SB200a PCB Stackup and Construction Builder  



 

Set by Layer Type 
Specify the percentage of copper for each layer type, signal, 
mixed or plane, that will be embedded in the adjacent 
prepreg. 

Proportional to Coverage 
Specify finishing dependant upon actual copper coverage to 
allow the values to be modified on an individual basis. 
Copper coverage is inversely proportional to the degree of 
copper embedding. The amount of the copper embedded 
can be expressed as: 
 

Ce = Cu(1-Cc/100) 
 

where 
Ce is embedded copper 
Cu is trace thickness 
Cc is copper coverage as a percentage 

The copper coverage for each layer can be set individually 
under Properties.  
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Simple Percentage Method 
The Simple Percentage Method allows the user to set the 
percentage of Prepreg base height, which will be used to 
determine the Isolation Distance. The percentage is set for 
each electrical layer type pair.  

• Signal – Signal 

• Signal – Mixed 

• Signal – Plane 

• Mixed – Mixed 

• Mixed – Plane 

• Plane – Plane 
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Environment Settings 
From the Tools menu choose the Options command to 
display the Configurations Options dialog. 

Controlled impedance calculations 

 

To activate the SB200 controlled impedance function, ensure 
that the Si8000 or Si9000 is installed and click on either Use 
Polar Si8000 License or Use Polar Si9000 License option 
as appropriate. 

Choosing default file locations 
Users can choose which materials library the SB200 uses at 
start-up. Click the File Locations tab and use the Browse 
button to navigate to the library (.mlbx) file. 
In addition a default location for stackup or project files may 
be specified. Browse to the folder and click OK ot confirm 
(create a new folder if necessary). 

 

Choosing background and stackup layer colours 
Choose the Colours tab to change stackup component 
colours from their factory defaults. 
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Specifying the default view and opening file 
Select the General tab to specify the Default Stackup View 
(two or three-dimensional). 

 
From the Display Data section select which data to display 
alongside the stackup; from the Print Report section select 
which data to display in the printout, click the Open last 
used… check box to specify that the SB200 should open the 
last used file on start-up. 

Security — setting passwords 
The SB200 security system provides for multi-level password 
protection. If a User password is defined, it will be requested 
each time the SB200 is started. Setting an Administrator 
password will prevent unauthorised changes to the SB200 
configuration. 
Select the Passwords Tab, and then Log In 

 

Default Passwords are blank for both the User and the 
Administrator. With blank passwords the password protection 
is transparent, and no protection is provided. 
Click Set New Password 
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Chose whether it is the User password or the Administrators 
Password that is to be changed. 

 
Enter the existing Password; this will be validated when 
moving to the Enter New Password text box. If the password 
is incorrect the focus will not leave the “Enter Password” text 
box. 
Enter the new password, then retype it in the Confirmation 
text box which will appear. The two passwords will be 
compared and if different will enforce password re-entry. 
Note: the new Users password will not be applicable until the 
program is re-started. 
The Administrators password will be requested each time the 
Configuration Options are opened. 

Specifying default trace parameters 

 
When adding a new structure default values are entered for 
the trace widths and separations. These values are set under 
the ‘Defaults’ tab 

Specifying minimum drill hole size 
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In the Drilling section set the default value for the minimum 
drill hole size 

Specifying default board thickness 

 
In the Board Thickness section set the default values for 
board thickness and tolerances. 

Specifying Goal Seeking Parameters 
Click the Goal Seeking tab to specify the defaults for trace 
widths and separations used during goal seeking. 

 
During goal seeking the calculated value for impedance will 
progressively converge upon the target value. In the 
Convergence text box specify the difference between the 
target impedance and the actual impedance at which goal 
seeking will stop. 
Use the Maximum Iterations text box to limit the number of 
iterations used during goal seeking. 
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Creating a new stackup 
Stackups may be created using the Stackup Wizard or 
manually using the editing window. 

Using the Stackup wizard 

 
Stackup 
wizard 
button 

The Stackup Wizard guides the user through the process 
of creating complex stackups in only a few steps. Click 
the Stackup Wizard button or choose the Stackup Wizard 
command from the File|New sub menu. The stackup 
editing window is cleared and the Stackup Wizard is 
displayed. 

 

Stackup Wizard 

Using the Wizard the user can specify the layer count and 
build type, stackup materials, planes and drill types in a 
single operation. 

Electrical layer count 
Begin by specifying the electrical layer count — up to 64 
electrical layers may be specified. Choose the number of 
layers from the drop down list box. 

Build type 
Choose the build type (Foil or Core) from the drop down list 
box. Core builds contain only core materials; most builds will 
be foil builds — containing internal layers of cores with two 
outer cores. 
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Choosing stackup materials 
Note; if Core build type has been specified the Foil material 
control will be disabled. 

 
Add material 
button 

To include a foil layer click the Foil Add Material button; 
the library of foil materials is displayed. 
Choose the foil material from the list of materials available 
and click the Select Highlighted Material button; the 
material is added as a foil layer to the stackup. 

 

Repeat the procedure for prepreg and core materials and the 
(optional) solder mask layers. 
Use the Clear button to remove a layer from the stackup. 

 

Stackup materials selected 

Nominating power planes 
Use the drop down list box to specify that a plane should be 
a power plane. Select all planes as required. To remove a 
power plane from the list select the plane number from the 
list and click Remove. 

 

Layers 4 and 5 specified as power planes 
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Adding drill information 
To add a drill information between electrical layer 1 and the 
last layer click the Through-Plated and Non-Through-Plated 
check boxes as required. 
With all build options specified click Apply to complete the 
stackup. The finished stackup appears in the stackup 
window. 

Filtering Materials 
When using the Stack Wizard, adding or swapping materials, 
available materials (Foils, Prepregs, etc.) are listed in the 
associated material library dialog. Lists can be filtered for 
materials matching desired parameters (dielectric thickness, 
Er, etc.)  

. 
In the library window click the ‘Filter’ button to display the 
Set Filter String dialog. 

 
Filter strings can be created and saved for future use. To 
recall an existing filter click the Load Filter button, choose the 
filter file and click OK. 

Building the filter string 
Build the filter string by selecting parameters, operands and 
criteria from the drop-down boxes. If the AND/OR box is 
selected another row is automatically added to the grid. The 
filter language is a sub-set of common database commands. 
Use the Up/Down buttons to select a row for deletion. The 
arrowhead at the side of the grid indicates the selected row. 
Click OK to apply the filter immediately to the selected 
library. If desired, save the filter string for future use. (The 
SB200 provides for interaction between the library dialog and 
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filter form. This allows complex strings to be built line-by-line 
and tested without saving until the string is completed.) 
When saving the filter choose a descriptive name for the file 
that reflects the purpose of the filter. The SB200 
automatically names the files for the material type. 
Click the Clear Filter button to display all materials of the 
selected type. 

Creating and editing stackups 
The SB200a allows the designer to add or edit stackup 
layers in any order, from top to bottom, bottom to top or from 
the centre layer outwards. In this example we create a four-
layer stackup, starting at the centre core layer and adding 
layers above and below. 

Adding layers to the stackup 

 
Display 
materials 
library 

Items added to the stackup are added from the currently 
open materials library. The SB200a opens Program 
Files\Polar\SB200\default.mlb if it exists; if a different library 
is required, open it via the Materials Library command. 

Note: the SB200 does not ship with the default.mlb library. 
For this discussion open one of the two sample library files, 
SB200 inch.mlb or SB200 mm.mlb (stored in the Program 
Files\Polar\SB200\Samples folder at installation time for a 
default installation.)  
Caution: Consistency of units 
When defining dimensions for a stackup (for example, layer 
thicknesses) ensure that all measurements are defined using 
the same units (mils, mm, etc.) throughout the structure and 
its libraries. 
Note: the libraries supplied for these examples are preloaded 
with sample data only. 
Click the File|New command to clear the stackup screen and 
notes and information text areas. 
Click the File|Save Stackup or Save Project command to 
save the stackup or project. Users are recommended to save 
stackups or projects frequently during the stackup creation 
process to avoid data loss. Stackup files (.stk), project files 
(.sci ) and library files (.mlb) should be backed up to a secure 
location. 

Adding a core layer 

 
Click the Add Layer Material button and choose 
Core…the Core library is displayed 
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The Core library contains full details of the core material, 
including base and finished thicknesses, dielectric constant, 
and upper and lower copper thicknesses. 

 
Click on the column button to sort the library list by the 
selected column. Choose a core type from the list of cores 
and click the Add Above button 

 
Add core above selected layer. The core is added to the 
stackup screen. 

 
Stackup core layer 

Layers may also be added below the selected layer.  

 Add core below selected layer 
As each layer is added the stackup information table is 
updated to reflect the current status of the stackup. 

 

Stackup information table 

With the core selected, the Selected Item table displays the 
properties of the core. 

 

Core layer information 
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Editing the selected layer properties 
To change the properties of the selected object (for example, 
to modify the value for the finished thickness of the 
dielectric), right click the object in the stackup and choose 
Properties from the shortcut menu; in this example the Core 
Properties dialog is displayed. 

 
Change the Dielectric finished thickness to the corrected 
value and click Apply. 

Adding data file names 
If available, add the data file name(s) to the upper and lower 
copper layers and click Apply. 
Close the dialog when all changes are completed. 
Changes will be reflected in the Stackup Information table 

Changing a layer function 
In this example we change both signal layers above and 
below the core dielectric to planes. 

 
Set Layer 
Plane 

Click the lower signal layer and click the Set Layer Plane 
button. Repeat for the upper signal layer.  
The changes are reflected in the stackup window 
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Exchanging layers 

 
Library Swap 
button 

To change just the core dielectric (leaving the copper 
layers unaffected), select the core material (for example the 
FR4 in the graphic above) and click the Swap Selected 
Material button. Choose the new core type from the library 
and click the Swap button. 
The layer properties will change to reflect the new material 
and changes appear in the Stackup Information table. 

Adding Prepreg layers 

 
Add Layer 
Material 
button 

With the core selected, click the Add Layer Material button 
and choose Prepreg…; the Add Prepreg library is 
displayed. 

 
The Prepreg library contains details of the Prepreg material, 
including the Prepreg’s base and finished thickness and 
dielectric constant.  

 
Add Prepreg 
Above 

Choose the Prepreg material from the database and click 
the Add Prepreg Above button. 

 
The Prepreg layer is added above the core. 
To change the properties of the Prepreg material right- click 
the layer and choose Properties from the short cut menu. For 
example, the value for Finished Thickness can be modified 
to reflect the effects of the pressing process. 
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Add Prepreg 
Below 

Click the Add Prepreg button to display the Add Prepreg 
library and click the Add Below button 

The layer of Prepreg is added below the core. 

 
Modify the properties as necessary. 

Adding a layer of copper foil 
Select the upper layer of Prepreg and click the Add Layer 
Material button and choose Foil to display the copper foil 
library. 

 
Choose the foil type and click Add Above, the copper foil 
layer is added above the selected Prepreg layer. 

 
Repeat the procedure for the lower Prepreg layer: select the 
lower Prepreg layer and add a layer of copper foil below the 
layer. 
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To alter the foil properties, right-click the foil layer and 
choose Properties. Using the Properties dialog the user can, 
for example, specify that the trace is shown inverted. 

 
Note the stackup is built symmetrically about the centre 
layer. 

Adding solder mask layers 
With the upper layer of foil selected, click the Add Layer 
Material button and choose Soldermask to add a layer of LPI 
solder mask above the foil. Repeat the process for the lower 
foil layer. 

 

Adding the Ident layers 
Select the lower LPI Soldermask layer and click the Add 
Layer Material button and choose Ident to add a layer of 
Screened Ident below the layer. The sample Ident library 
includes ink thickness and colour 

 
Repeat for the upper layer. 
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Adding drill information 
To add drill information between layers click the Add Drill 
button; the Add Drill dialog is displayed. 

 
Select the column in which to place the drill. 
Choose the first and second electrical layer numbers (layers 
1 and 4 in the example). 
Specify the drill type, mechanical or laser and whether 
through plated. 
Optionally, add the NC drill data filenames. 
Optionally, add the hole count, number of different hole sizes 
and the minimum hole size. Click Add and close the dialog. 
The drill information is added to the stackup. In the example 
we have added through plated and laser drill information. 
This completes the stackup; the finished stackup is shown 
below 

 

Completed stackup 

Deleting a layer 

 
Delete layer 

To remove a layer from the stackup select the layer and 
click the Delete button. 
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Copying layers 

 
Copy 
Material 

With layers defined it will often be found more convenient 
to copy an existing layer and paste it into the stackup than 
to create a new layer “from scratch”. Select the layer to be 
copied and click the Copy Material button. 
Click the layer nearest the destination location and choose 
Paste Above or Paste Below as appropriate 
Note: when modifying the stackup it may be necessary to 
redefine the drill information to reflect the changes. 

Moving layers 

  
Move 
selected 
layer up one 
layer 

  
Move 
selected 
layer down 
one layer 

To move layers within the stackup use the Move Up and 
Move down buttons. 
 
 
When a layer is moved it is exchanged with the layer above 
or below, respectively. 

Applying finished thicknesses 

 
Apply 
Finished 
Thickness 

 

 
Reset 
Finished 
Thickness 

To apply the finished thickness factor throughout the board, 
click this button with no layers selected, otherwise the 
finishing will only be applied to the selected layer 
 
To reset the finished thickness back to the original base 
thickness of the materials throughout the board, click this 
button with no layers selected, otherwise the reset will only 
be applied to the selected layer 

 

Displaying the stackup in 2-dimensional view 

 
View 2D 
button 

To change the view of the stackup from its default 3-
dimensional aspect, click the View 2D button. 

The stackup is displayed in 2-dimensional view. 
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Display 3D 
button 

Click the View 3D button to restore the 3 dimensional view. 
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Design Rule Checking 
The SB200a includes facilities to check for errors in stackup 
design, such as layers placed in invalid order or 
asymmetrical structures. 
The Design Rule Checker (DRC) displays results in the DRC 
dialog. As each design rule is broken the SB200a increments 
the error count on the DRC tab. 

Viewing design rule errors 
Click the DRC tab to view errors. 

 
The Design Rule Checker checks include checking for: 
Two Adjacent Copper Layers 
Resin Coated Copper on Internal Layer 
External Prepreg 
Internal Solder Mask 
Internal Ident 
Internal Peelable Mask 
Symmetry – Different Material Types 
Copper not Balanced 
Board Thickness (If the board is outside tolerance the Stack 
Information in the Stack editor is displayed in red) 
Manufacturing tests 

• Minimum Trace width (Test carried out when calculating 
Controlled Impedance) 

• Minimum Trace Separation (Test carried out when 
calculating Controlled Impedance) 
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• Drill Aspect Ratios for Plated holes 

• Track Aspect ratio 

• Excess Resin test 
If the Excess Resin check box is ticked values are shown as 
below; scroll through the layers as required 

 
Users can choose to display all errors or to select from a 
combination of Design Errors, Symmetry errors and Copper 
balance errors, etc.; check the boxes as required. 
Click on the errors shown in the list to highlight the errors in 
the stackup screen. Errors are highlighted in red. 

Correcting design rule errors 
Users are strongly recommended to work through and 
correct errors in the order in which the errors are listed. Note 
that clearing each error may clear other errors in the 
process. 
Manufacturing tests should be fixed before sending the PCB 
for manufacture. Hole sizes should be adjusted to comply. 
Failures with track and gap should be corrected, possibly by 
changing prepreg thickness and/or dielectric constants. 
A collection of manufacturing constraints can be defined and 
the required one selected. 

Creating and using manufacturing constraints 
From the Tools menu, select Manufacturing Constraints: the 
Manufacturing Constraints window opens, displaying any 
manufacturing constraints added. 

 
By default there will always be at least one. It is important to 
always have one constraint set active. 
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Double-click on a constraint row will bring up the Edit 
Constraints dialog; use the dialog to add, delete or edit 
constraints. 

 
To Edit a constraint set, use the navigation buttons to select 
the set to modified, change the values as required and then 
press Done. 
To Delete a constraint set, use the navigation buttons to 
select the set, then press Delete. 
To Add a new constraint set, press the Add button, this will 
add a new (empty) constraint row, enter the name and 
constraint values and press Done. 
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Adding controlled impedance structures 
The SB200 incorporates the facility to add controlled 
impedance structures to a layer in the stackup. The SB200 is 
integrated with the Polar Instruments Si8000/9000 Controlled 
Impedance Field Solver so impedance values for a structure 
may be calculated at the click of a button. 
Structure parameters may be copied to the Field Solver for 
processing (for example by the Si8000/9000 Goal Seeking 
function) and calculated values pasted back to the SB200 for 
insertion into the stackup. 
In this example we add a controlled impedance structure to 
signal layer 4 of the sample stackup below. 

 

Sample stackup (showing signal layer 4 selected) 

Note that in this example layer 5 is a mixed signal/plane 
layer. Potential reference planes for signal layer 4 are 
therefore plane layer 2, mixed signal/plane layer 5 and plane 
layer 7. 
With layer 4 selected, click the Controlled Impedance tab. 
The Add Structure button is displayed. 

 

Click the Add Structure button; the Structure Control dialog 
is displayed containing the controlled impedance structures 
applicable to the selected layer in the stack. Choose values 
for the target impedance and tolerance. If necessary, resize 
the Structure Control dialog to view all structures. 
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Click the Single Trace, Differential or Broadside option button 
as appropriate (in this case, we choose Single Trace|Offset 
Stripline 1B1A). 
Note: Broadside only appears as an option where the signal 
trace is between two reference planes. When selecting 
Broadside structures it will be necessary to choose the 
second trace. 
Specify the values for Target Impedance and Tolerance. 

Choosing reference planes 
As there are multiple reference planes available (layers 2, 5 
and 7, it will be necessary to specify which planes to use for 
this structure. Click the Advanced button. 
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Choose a reference plane from the list of available planes. In 
the example structure plane layer 2, mixed plane 5 and plane 
layer 7 are available for reference. 
Note: if plane layer 7 is chosen as reference, it will be 
necessary to take into account the electrical effects of mixed 
signal/layer plane 5. 
In this example we choose mixed signal/plane layer 5. Press 
OK to confirm. 
Repeat for all structures to be added. Click Apply for each 
structure then click Done to finish. In this example we 
choose a single structure. 

 
The stackup window changes to reflect the selected signal 
layer and its associated reference planes. 
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The applied structure is displayed in the Controlled 
Impedance pane. 

 

The window displays the parameters of the controlled 
impedance structure. Fields shown "greyed out" are values 
derived from the choice of materials in the stackup. For this 
structure, enter appropriate values for lower and upper trace 
widths. 

 
Calculate 
button 

Click the Calculate button to display the impedance value 
of the structure with the current parameters. The 
parameters may then be varied to alter the value of the 
final impedance. 
In the example above the user can vary the trace width in 
order to approach the value of the target impedance; other 
parameters are changed by modifying the stackup 
dimensions (for example, core thickness H1). 
Clicking Apply All in the Structure Control dialog adds a 
single instance of all structures matching the stackup layer 
and the chosen criteria; the user can then choose the 
structure producing the value nearest the target impedance 
and delete the structures that are not needed. Controlled 
impedance operations are performed via the Controlled 
Impedance toolbar. 

 
Controlled Impedance toolbar 
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 Add controlled impedance structure to current layer 

 Delete structure from current layer 

 Clear all structures from current layer 

 Refresh and calculate impedance 

 Calculate structure 

 Mirror Structures 

 Goal Seek 

 Display layer and Navigate 
through structures 
Changing parameter values 
Clicking the Calculate function yields a value for impedance. 
The user can now vary parameters (for example, the 
dielectric height) to yield a value for impedance closer to the 
target impedance. For this example, select the dielectric 
layer; click the Swap Selected Material button and choose a 
different core (ensure the same dimensional units are used 
throughout the structure) and click the Refresh and Calculate 
Impedance button. The impedance is recalculated to its new 
value. To arrive at a solution acceptably close to the target 
impedance, use the goal seeking function of the Si8000 to 
alter other parameters (in this case, upper and lower trace 
widths). 

Goal seeking with the Si8000/9000  
The SB200 Stackup Design System is fully integrated with 
the Si8000/9000 Controlled Impedance Field Solvers. The 
user is able to transfer stackup layer dimensions to the Field 
Solver, solve for stackup parameters to produce the target 
impedance (or calculate that the target impedance is 
unachievable with the current values) then transfer the 
solved dimensions back to the SB200. 
Ensure the Field Solver is running and that its units match 
the SB200 units. With the stackup parameters displayed in 
the Controlled Impedance window, click the Copy to Field 
Solver button to transfer the current SB200 parameters to 
the Field Solver. Switch to the Field Solver and click the 
Paste from SB200 button to load the parameters into the 
associated Field Solver fields. 
For the example data below we seek a final value for 
impedance of 50 Ohms; H1, Er1 and T1 are fixed. 
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Field Solver parameter fields with SB200 data loaded 

Click the Upper Trace Width Calculate button to goal seek on 
trace width. The Field Solver returns values for trace width to 
produce 50 Ohms final impedance. 

 
Solved values for impedance 

Click the Copy to SB200 button, switch to the SB200 and 
click the Paste from Field Solver button to display the solved 
parameters for the target impedance. It may be necessary to 
round some dimensions (e.g. dielectric heights) to the 
nearest practical values and recalculate the impedance. 

Using the SB200 materials libraries 

 
Materials 
Library 

The materials libraries allow designers to manage their own 
libraries of board materials. 
Click the Materials Library button to display the Materials 
Library window. 

When the SB200 is started the material library specified as 
the default materials library file (via Configuration 
Options|File Locations) is opened. 

 
Each library component type is accessible via its associated 
tab. Click on the Tab to view or edit the component type.  

Using the SB200a Stackup Design System  •  39 



 

Materials library toolbar 
The Materials Library is managed via its toolbar 

 

 Clear Materials Library 

 Open Materials Library 

 Save Materials Library 

 Import Material into the Library 

 Select & arrange Column fields 

 Save column arrangement 

 Load column arrangement 

Creating a new library 
To create a new library, click the Clear Materials Library 
button; the library is removed from the library manager. Click 
the Save Materials Library button to create the new library. 
To have the library load as the SB200 starts, specify it as the 
default materials library file via Configuration Options|File 
Locations. 

Adding material to the library 
Caution: consistency of units 
When defining dimensions, e.g. layer thicknesses, for a 
stackup ensure that all measurements are defined using the 
same units (mils, mm, etc) throughout the structure and its 
libraries. 
Open the library to be modified. To add materials to a library 
click the associated component type tab; click onto a 
material, or empty line. An editing box will open which will 
contain the material clicked on, or the last material in that 
type library. The material can be edited or deleted, or a new 
material can be added. To speed up the process of adding 
families of materials, when a material is added the properties 
of the last material are copied to the new material. The 
details can then be edited. Clicking OK will add any new 
materials to the end of the list. 
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Importing material to the library 
The SB200 allows users to add existing material lists to its 
library; material data must be arranged in the format and 
order used by the SB200 library. Sample files in comma 
separated value format and Microsoft Excel spreadsheet and 
template formats suitable for importing to the SB200 are 
included in the SB200|Material Library Import folder. Click 
the Materials Library button to open the Library, and then 
click the Import button to open the Import dialog. 

 

Library Import dialog 
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Creating a new materials library 
Choose the Start New Library option and choose the field 
delimiter type. The library import function can accept files in a 
variety of formats, tab delimited, comma separated and Excel 
worksheet and template formats. Sections of the sample files 
included with the SB200 are shown below. 

 
Sample library file in Microsoft Excel format 

 
Sample library file in comma separated format 

Files for importing into the library must be in the above 
format, with columns in the correct order. Examine the 
sample files supplied in the Material Library Import subfolder 
for more information. (It may be helpful to export data files 
from the current system into Microsoft Excel and save in 
Microsoft Excel workbook or text file format.) 
Specify the delimiter if necessary and choose the file type 
(Foil, RCC, Prepreg, etc.) and click Apply. Choose the file 
from the list displayed in the Open dialog and click Open. 
Repeat the procedure for every file type; Click Done when all 
file types have been imported. Save the file as an .mlbx 
library file. 

Adding material data to an existing library 
To add material data to an existing library, open the library 
and click the Import Material button 

Selecting Materials from the Library 

Column Order (Materials Library) 
The default setting displays all columns. The columns 
displayed and the order they are displayed can be set in the 
materials Library form. 

Arranging Columns in Library Forms 
The Library windows can be customised in respect of which 
columns to display and in which order. 
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Click the Go to Materials Library button and select Arrange 
Columns; the dialog associated with the selected material 
tab (Foils, Prepregs, etc.) is opened. 

 
The Left box of the dialog shows the columns that will be 
displayed and the order top to bottom is the order they will be 
displayed left to right in the library window. 
Click Accept to return to the Materials Library, which will 
show the columns as set.  
Until the column order is saved the column order is only 
available during the current session. Click Save Column 
Order to define the selected column order as the default 
order whenever the program is run. 
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